Canon Macintosh

Image Viewing, Organizing and Editing Software

ImageBrowser
Ver. 6.6
Instruction Manual

In this manual, IB is used for ImageBrowser.

In this manual, the windows used in the examples are from Mac OS X 10.4.

Click on the icons below on the bottom right of the screen to switch
between pages.

@ : Go to next page @ . Go to previous page
. Return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to
the contents page of each chapter.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of IB

Download images to your computer
Check images

Print images

Organize images

Edit images
Adjust images
Trim images
Insert text
Correct red-eye
Change image size and type

Utilize images
Attach an image to an e-mail
Create wallpaper or a screen saver

Convert images
Change image size and type

Play Movies
Use your images with CANON iMAGE GATEWAY
Sym bols Used

: Selection procedure for menus that appear on the computer
screen
[ ] :Names of items and menus, buttons, windows, etc. that appear on
the computer screen
: Camera switch name or icon, or a keyboard key name
: Reference page (jump to page by clicking)

< >
p.**
"2 :Help 2@ Tip

: Important information |§| : Helpful information

Makeup of Each Chapter

Chapter 1 Basic Operation
Starting up and quitting 1B
Downloading images to your computer
Checking images
Playing movies
Printing images

Chapter 2 Advanced Operation

Efficient checking of images
Organizing images

@ Editing images

® Editing movies

© Utilizing images

©® Index printing

) Layout printing

Chapter 3 High-Level Functions
Checking images with high-level functions
Organizing images with high-level functions
Advanced image editing

Chapter 4 Preferences
Settings for all functions

Chapter 5 Using Images on the Internet
Using CANON iIMAGE GATEWAY

Reference
Solving problems

Uninstalling IB

System requirements

Supported images

Lists of primary window functions
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1 Basic Operation

Starting UP IB ..o 7
Downloading an Image to Your Computer ................ 7
Downloading Images Using Your Card Reader............ 8
Viewing an IMage .......ccoooevveeiieii e 9
View Images as Thumbnails in the Main Window ...... 10
Changing the Display Magnification ....................... 11
Enlarging and Viewing Images One at a Time............ 11
Displaying an Image Across the Whole Window (Full
VIEW DISPIAY) ... 12
Playing MOVIES .......cccoooviiiiiiiiiieeeeeeeeeeeee 13
Rewriting Images to a Memory Card.......................... 14
Printing an Image ... 15
QUITING 1B .iiiii i 16
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Starting up IB

Click the icon on the Dock.

Click

IB starts up and the main window (browser window) appears.

v

Main window (browser window)

® Imigefrowier Fie fax emet Windem  Feip 4 TermosAM @
ana [, .

g wcmesed o pous camars [ e
oy Spensha )

Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and

download the images saved on the memory card inserted in the camera.

For downloading images, start up the camera software “EOS Utility” and
use.

Connect your camera and computer and turn the
camera on.
When IB starts up, connect the camera and your computer with the
interface cable provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF
electronic manual).

EOS Utility starts up automatically.
EOS Utility

800 EOS Utility - EOS XXX

Control Camera Accessories

Starts to download images

Lets you select and download images

Camera settings /Remote shooting

Monitor Folder
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Download images.

enn EOS Utility - EOS XXX

Control Camera Accessories

Starts to download images CI|Ck

Lets you select and download images

Camera settings /Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the [Pictures] folder and
are displayed in the main window of IB.

The downloaded images are sorted into folders by date and
saved.

Click the EOS Utility [Quit] button to quit EOS Ultility and turn the
camera’s power switch to < OFF >,

i@/i- Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card

reader.

Start up IB and then select the save destination for
the images in the folder area at the left of the main

window.

-

806

Images acquired from your camera

can be accessed here.

" Favorite Folders | “all Folders

)

vl Macintosh HD
B A Applications
[¥ Photo
¥|.£ Users
¥ {§ canon
»{F Desktop
b Documents
4 Movies

»{_ Shared

—— Click

Load the memory card into the card reader.

Download images window appears.
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Download images.
Download images window

ImageBrowser Canon

[ Download Images ] Click

Lets you select and
| download images

[ Print Menu ]

Preferences... Exit

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of IB.

The downloaded images are sorted into folders by date and
saved.

Click the [EXxit] button to quit Download images window.

-2\@/3 Advantages of using IB to download images

Using IB to download images makes it easier to organize your images
as they are downloaded, sorted and saved into folders by date.

® Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your
camera and computer with the provided interface cable, and
transfer the images to your computer.

Viewing an Image

Images and movies downloaded to your computer are displayed as
thumbnail images in the main window. You can double-click a thumbnail
to open the viewer window and display an image at a larger size or play
a movie.

Main window

@ ImageBrowser File Edit View Internet Window Help
(806 [ Browser Window

<4 TueS1lPM Q@

Images acquired from your camera PreviewMode | List Mode
n

can be accessed here. n

File Name: IMG_0001
Modified XX/ XXIXXKX
File Size: 70M8

Image Size: 3888 x 2592
Data Type: PG

)

Introduction
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High-Level
Functions

View/Modify Keywords

¥ Brightness Hsitogram

IMG 0003 JPG IMG, 0004 PG

IMG_0002JPG IMG 0005.JPG

o=

;;;;;;;;

The clicked image is enlarged and
displayed in the center of the window

Displays the images in the folder that was selected
from the folder area on the left of the window
To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.
You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that
appears.
When you have selected a movie, the first frame shot is
displayed in the center. For playing movies, refer to p.13.

Click to select the image

@ For a list of main window functions, refer to p.73.
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View Images as Thumbnails in the Main Window

You can change the display mode of the main window to show only a list
of the thumbnail images.

Click the [List Mode] tab sheet.

File Edit View Internet Window Help

camera [—merﬂedz—l-l List Mode 1'

Click
The main window display changes to List Mode.

[ B

Main window (List Mode)

@ ImageBrewser File  Edt View  Intermet  Window Help
6ns

Images woquiresd Fom you camera
can be accrnsed heve.

NG, 0018 P

o gt Aariad 1 Tt T8 magin

Click to select the image Displays the images in the folder
that was selected from the folder
area on the left of the window

To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.

You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that
appears.

@ For a list of List Mode functions, refer to p.74.
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Changing the Display Magnification
You can change the display magnification of the thumbnail images
displayed in Preview Mode (p.73) and List Mode (p.74).

Change the display magnification.

view [ fier ou , |.......e,.._....... Q q |
> — 4

i & 4. =2 K

Canon Camera View Image lideShow CANON IMAGE Print & Email Send to T|

GATEWAY

Drag left or right

@ You can also change the display magnification by clicking [ &, ]
or[ & 1.
-» The display magnification of the images changes.

o WA @

Enlarging and Viewing Images One at a Time

1 Double-click an image to enlarge.
Double-click

@ ImageBrewser File  Edt  View  dhtermet  Window  Help
[-Xa1-]

Images woquiresd Fom you camera [ Preview
can be accrnsed heve.

G001 JPG G 0018 JPG [T NG, 0018 P

Add.

[Ty i ot e Acactad | ot 14 imagin

=» The viewer window appears.

G
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Introduction

Click [ 4] or [ ] to switch to the image you want to Displaying an Image Across the Whole
display. Window (Full View Display) Table of

; ; Contents
Viewer window Double-click on the image you want to display

806 & IMG_0001.JPG (1/16) .
across the whole window.
Advanced
Operation
High-Level
Functions
[ 4 __i Preferences
T s 3882592 o [ /
_ (owidow Bt g @ You can also display the image across the whole window by
b ‘ $ & = N 3 = 2 clicking [ 2 1 (Full Screen) on the bottom of the window. Usingsthe
— T AR =» The image is enlarged and displayed across the whole window. Internet
The shooting information is displayed if you click [ <2 ] (Show
Shooting Information) and select [Show Shooting Information]
from the menu that appears. Reference
To quit the viewer window, click [ €3 ] on the top left of the
window.
Contents
Lookup
Index

-

QO

To return to the viewer window, click on the window or press the @
12

? When you display RAW images in the viewer window

The [Show Original Image] button appears at the bottom of the window.
Click this button to display the processed image.

|§| For a list of viewer window functions, refer to p.75. < esc > key on the keyboard.



Playing Movies

You can play movies that you have shot. Movie files are marked with the
[ ] icon in the thumbnail image frame in the main window.

In the main window, double-click a movie (image
marked with the [ =] icon).
Double-click

@ ImageBrowser File Edit View Intdmet Window Help @ TuesllPM @
006 {2 Browser Window

A viewer window appears.

Click the [ » ] button.

ana B MVILO000.MOV(1/17)

" -
"t{(
T — —
( Save as Still Image... Cut Movie...
Fit 1o window B vrsrvrrr
4 » @&. EH. i = .

Rk Nt Save tae Nember of Driplayt  Synchronise Fall Sereen Pring Show
Infarmation

» The movie begins to play.

@ Playback stops automatically when the movie ends.

©® To play the same movie again, click the [ ¥ ] button.

@ You can save the currently displayed scene as a still image by
clicking the [Save as Still Image] button.
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Rewriting Images to a Memory Card

You can rewrite images and MOV movies that you have saved on a
computer to a memory card and then play them back on the camera.
Use a third-party card reader to rewrite your images or movies to a
memory card.

Insert a memory card that has been formatted on the
camera into the card reader.

Select the image or movie you want to rewrite.

1 @

@ imageBrowser File Edn View imterner Window Help 3
000 3 browser Window

can ba sccessed e,

Rewrite the image or movie.
Select the [File] menu » [Rewrite Image to Memory Card].
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Select the destination memory card and click the
[OK] button.

P = =
enn ImageBrowser

Select Memory Card

"EOS_DIGITAL B

( Cancel ) ('—'H

A confirmation window appears.

Click the [Transfer] button in the confirmation

window.
Image or movie exporting begins.

® You cannot rewrite MOV movies that have undergone movie
editing (p.34) to a memory card.
AVI movies cannot be rewritten to a memory card.

Printing an Image

This section explains how to print one image on one sheet of paper.

Select the image to be printed.

W imagrirewiar e View ireemer WindowWin T Twsuim @
ane Bovmaas Wt

e T, e e " |

Click

@ To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.

@ You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that
appears.

Display the print settings window.
Click the [Print & Email] button and then select [Photo Print] from
the menu that appears.

Photo Print...
_ Index Print...

| | 1 E o
e &, @, || 3 Layout Print... 71| &
! ! Create Image for Email...
.. E 3 @ . ——_—
NON IMACE Print & Email Send to Trash FANON iIMACE Print & Email Send to Trash
GATEWAY CATEWAY

The [Photo Print] window appears.
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Set the paper size and other settings, and then click
the [Print] button.

Photo Print window

(@06

Pheto Print

Printer

Canon XXX A

Paper size :
A4

Click [Page Setup] to enable
borderless printing on
supported printers.

Shooting Date/Time

None 49

Properties

Quitting 1B
In the main window, select the [ImageBrowser] menu
» [Quit ImageBrowser].

ImageBrowser

About ImageBrowser...
Preferences... ®,

Services [ d

Hide ImageBrowser 3H
Hide Others 3EH
Show All

Quit ImageBrowser  3£Q )

sml Remove unwanted regions
_==r | of your photo.

| 5]

Add some text to print
with this photo.

E”E‘ Image: 1/1

Copies:

™

1

Total :

1 pages

C

Close

Print

]

),

Printing begins.

@ For a list of photo print window functions, refer to p.77.

IB quits.

)
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Checking/Sorting Images

You can enlarge images one at a time from a list in the main window,
check what they look like in detail, and sort them with ratings.

Enlarging and Checking Images One at a Time

Double-click on the image on the top left of the main
window.
Double-click

The viewer window appears.

Click [ 4] or [ ] to switch to the image you want to
display.

Viewer window

8066 & IMG_0001.JPG (1/16)

I_ Fit to window IC] W AT
4 > ‘ & & = H = = 2.

Back Next

Save Edit  Number of Displays Synchronize  Full Screen Print Show

Image Size: 3888 x 2592 |

Display: 19 % P

The shooting information is displayed if you click [ =2 ] (Show
Shooting Information) and select [Show Shooting Information]
from the menu that appears.

To quit the viewer window, click [ ) ] on the top left of the
window.

When checking RAW images, always click on the [Show Original
Image] button and check the processed images.

=@< To display only selected images in the viewer window

Select multiple images in the main window (p.10) and then click on
[ ™= ] (View Image) (p.74) on the bottom of the main window to display
only the selected images in the viewer window.

@ For a list of viewer window functions, refer to p.75.

)
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Enlarging a Specific Part of an Image

Enlarge an image.
Click the list box and then select the display magnification.

= = ™ L
Fit to window | -] 0 YT UL
A EE| N
,,i =
- 23 - 5=

Save Edit

+ Fit to window
200%
175%
150%
125%

‘ 100% ;" ‘.J

75% o

MNumber of Displays Synchroni: Save 50%

(e e
ALl A

bys  Synchroni

25%

The image enlarges and the navigator window appears.

Display the part of the image you want to check.
Drag the enlargement display position in the navigator window
and display the part of the image you want to check.
Navigator window

ana B aG_0001 PG (1/16)

Enlargement
display position
Drag to move the
display position

Display magnification

To return to full view, select [Fit to window] from the list box.

? Enlarging RAW images

RAW images cannot be enlarged before they are processed. By clicking
the [Show Original Image] button on the bottom of the window, the
image is processed and it can be enlarged.

Sorting Images

You can sort images into one of seven groups by setting ratings
according to the photo subject or a theme.
Ratings can be set from the following seven types.

K (none)! [ ,".‘], [ Ry ,".‘], [ ]! [ ]’ [ ]’
[Reject]

Increase or decrease [ .].

— Click to increase

! -

Number of Displays  Synchronize Full Screen Prir|

=h
=23 -~ b=

Click to decrease

[Reject] cannot be set in the viewer window. Set [Reject] in the
main window.

ﬁl You can display and change rating settings set in IB version 6.6

with other bundled software or on an EOS 60D camera.

» EOS Utility version 2.9:
Ratings set in IB version 6.6 are displayed on image thumbnails
in the viewer window. However, [Reject] is not displayed and
you cannot change rating settings.

+ Digital Photo Professional version 3.9:
Ratings set for still images in IB version 6.6 are displayed on
image thumbnails in the main window, etc. You can also change
rating settings.

* On an EOS 60D camera:
Ratings set in IB version 6.6 are displayed in the playback
screen. You can also change rating settings. However, you
cannot display or change settings for [Reject].

Reversely, you can also display and change with IB version 6.6

the rating settings set for still images in Digital Photo Professional

version 3.9 or on an EOS 60D camera.
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Sorting Images in the Main Window

Select images in the main window, and then select
the [Edit] menu P> [Change Rating] P> select the

setting.

ndo 37z

Select All HA

Rotate Image...
Rotate According to Rotation Information

Edit still image

Movie Edit...

Extract frames from a movie...
PhotoStitch...

Edit with Registered Application >

Keyword >
ange Ra 0

Special Characters... NHET

Deselect All
Select By My Category >

You can also click on a thumbnail image in the main window
while holding down the <control> key on the keyboard, and then
from the menu that appears select [Change Rating] P select the

setting.

Reject

Filtering Images You Want to Display

You can filter images displayed in the main window by the ratings you
have attached to them.

Click the [ ] button.
View [w g "',)—-—n—----_ Q Q[ gz 5| 8
SE | - i [ = 1§
£y ﬂ e d - L= ‘g
Canon Camera View Image SlideShow CANON IMAGE Print & Email Send to Tras|
CATEWAY

The filter function appears.

Set the criteria to filter images.

Filter by Rating: [ All . ]

e & .

Canon Camera View Image SlideShow CANON IMAGE Print & Email Send to Tras|
GATEWAY

+ Only the images with the criteria you have set are displayed in
the main window.
To quit the filter display, click the [ ] button again
and then select [Select All].

@ To users of ImageBrowser ver. 6.5 and earlier
The method for setting ratings has greatly changed starting with ver.
6.6.
Accordingly, a rating may be displayed differently even for the same
image between ver. 6.6 and ver. 6.5 and earlier.
For detailed information, refer to the Help for ImageBrowser ver.
6.6.
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Arranging Images in the Main Window
You can arrange images in the order of file size or shot date and time.

Select the [View] menu P> [Sort] P> desired item.

View

View Mode [ 2
View Settings >

IET Y,  File Name

) File Modification Date

Display > File Size
Erfl_f”ge ?ﬁ"' Shooting Date/Time
Reduce ExS Type
View Actual Image v Ascending
Show AF Frame Descending
Show Shooting Information
Slide Show...

Slide Show Options...

Refresh 2R

The images are arranged in the order according to the selected
item.

Sort item Description
File Name Image file names are arranged in the order of 0 -9 - a - z.

File Modification Images are arranged in the order of most recently
Date updated.

File Size Images are arranged in the order of the smallest file size.

Shooting Images are arranged in the order of most recently shot.

Date/Time

Type Images are arranged in the order of BMP images > RAW
images = JPEG images = MOV movies - PICT images
- TIFF images.

Ascending Images are arranged from top to bottom in order of

sorting criteria.

Images are arranged from bottom to top in order of

Descending ,1ing criteria.

Efficiently Checking/Sorting Images

With the Preview Mode that displays images as thumbnails and single
images in the same window, you can efficiently check the images. You
can also check the images’ shooting information or sort them by setting
their ratings.

Enable Preview Mode.

File Edit WView Internet Window Help

Famera [ Preview Mode Il List Mode

Click
The main window display switches to Preview Mode.
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171 Introduction
Organizing Images
Click on athumbnail image to switch to the image This section explains functions that are useful for organizing images
you want to check, and then sort by setting ratings. such as creating new folders for saving sorted images, moving and Table of
. : copying images and deleting unwanted images.
Click to increase or decrease pying imag g g Contents
Preview Mode
@ ImageBrowser File Edit View Internet Window Help ¢ Tues:llPM @ . .
— — Creating a Folder for Saving Images Basic
e o) . Operation
i I i You can create a folder to save sorted images.

7.0M8

\\\\\\\\\

In the folder area, select the location where the new Ad\@ed

folder is to be created. Opggiion
(0606

Images acquired from your camera High-Level

can be accessed here. Functions

| Favorite Folders h—ﬁﬂ'*}ﬂlﬂ—i Preferences

w2 Macintosh HD
B[4 Applications

IMC0001 PG IMC 0002 JPG. IMC 0003JPC IMC_0004 PG IMC_0005 JPG.

[Z Photo Using the
e A [ @@ ¥i Users Internet
’F;—a‘ e (inn:;(amzrz View fage thuw ugg::& Pinea Emad Sznd.mv‘mxh Nw . 9 I 711 canon
The selected image in the thumbnail ts Reference
image display area s enlarged in the E&Mwies
center of the window
Thumbnail image display area »{ I shared Contents
When checking RAW images, always click on the [Show Original Lookup
Image] button in the viewer window and check the processed
images.
When you have selected a movie, the first frame shot is e
displayed in the center. For playing movies, refer to p.13.
To set [Reject] for ratings, select the [Edit] menu P> [Change -
Rating] P> [Reject], or click on a thumbnail image while holding
down the <control> key on the keyboard and then select [Change @ @

Rating] » [Reject] from the menu that appears.

|§| For a list of Preview Mode functions, refer to p.73.

©



Select the [File] menu P> [New Folder].

The [New Folder] window appears.

Enter a folder name and click the [OK] button.

The new folder is created in the folder selected in step 1.

Moving Images

)

Introduction

. . Table of
You can move or copy images to separate folders and organize them Contents
according to shot date or theme.
Drag the image to be moved or copied. Basic
Operation

To move:Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the < option > key

and release when the image is in the destination folder.

(@06

Images acquired from your camera ( Preview Mode F-——-——hsr-ﬂoﬂe-—-——-]
can be accessed here.

Favorite Folders F——mﬁrﬂi
y S

= Macintosh HD
» [ Applications
¥/ B Users
v canon

| XXX XX XX

[:, Hxx_xx_01
[2 xooux_xx_02
[F xox_xx_03
[2 xaox_xx_04

IMG_0006.|PG

The image is moved or copied to the folder it was dragged to.
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Moving Images in Folders

You can move or copy folders that contain images, and organize images
in folders.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the < option > key
and release when the folder is in the destination folder.

(@00

7 - -
Images acquired from your camera Preview Mode  a— List Mode ’]
can be accessed here.

Favorite Folders I—-v":\il-Fnidcrs—-'--]

¥ Macintosh HD
»[A Applications
VL Users
¥ % canon
- Desktop
bt Documents
[-j: Movies
vfg Pictures
" iPhoto Library
[Z Photo
| XXX XX
I xooxx_xx_02
[ xxxx_xx_03
[ xxxx_xx_04 ' y v A

IMC_0001.JPG

o

The folder is moved or copied to the folder it was dragged to.

Changing File and Folder Names for Images

In the main window, select the image whose name
you want to change, or, in the folder area, select the
folder whose name you want to change.

Select the [File] menu P [Rename].

The [Rename] window appears.

)
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Enter the file or folder name of the image and then

click the [OK] button.
Rename window

-

Rename

File Name]

Photo

The file or folder name changes to the new one.

You can also change the file name in the [File Information]
window (p.49) or in the information display area (p.73) in Preview

Mode.

You can also change the folder name in the [File Information]

window (p.49).

Deleting an Image or Folder

Deleted images and folders cannot be recovered. Also, take care when
deleting folders as all the images inside a folder will also be deleted.

In the main window, select the image you want to
delete, or in the folder area, select the folder you
want to delete.

Click [Send to Trash].

| Selecting Images T|i E E ..J

2 \B

ACE Print & Email send to Trash

»The image or folder is moved to the [Trash] and is deleted from
IB.

® If the [Move to Trash?] dialog box appears, click the [Yes] button.

@ To delete an image or a folder from your computer, on the
desktop, select the [Finder] menu P [Empty Trash].
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Registering Frequently-Used Folders as Favorite Folders

You can register shortcuts for frequently-used folders in the [Favorite
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [Pictures] folder is registered as a favorite
folder by default, the folder icon appears as [ | ].

Select the folder you want to register.

Images acquired from your camera
can be accessed here.

" Favorite Folders | All Folders ]

¥4 Macintosh HD
b & Applications
¥ L Users
¥ % canon

b i Documents
[Z Maovies
L‘é! Fictures

E— — — — — — — % a»

| Add to Favorites |

Click the [Add to Favorites] button.

The folder icon changes to [__~;£ ] and the folder is registered as a
favorite folder.

Select the [Favorite Folders] tab sheet.

Select the registered folder to display the images

inside the folder.

Images acquired from your camera
can be accessed here.

[ Favorite Folders | All Folders

‘=X Pictures

Y

Favorites

s

Add... ‘ | Remove

The images inside the folder appear.

? If you have edited or deleted images in folders you have

registered as favorites

Any changes done to images inside registered folders will be applied to
the original images. Therefore, please be aware that by editing or
deleting images inside registered folders, you are in fact editing or

deleting the original images.

)
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Deleting Favorite Folders

If you no longer need a folder you have registered in the [Favorite
Folders] tab sheet, you can delete it from this tab sheet.

Please note that as registered folders are shortcuts, the original folder
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder
you want to delete and then click the [Remove]
button.

Images acquired from your camera
can be accessed here.

[ Favorite Folders | All Folders

{22 Pictures

€ .y

Favorites

Add... | ‘ Remove

The folder is deleted.

Editing an Image

If the brightness or color of images is different from what you visualized
when you shot the photo, you can adjust an image using the editing
functions to bring them closer to what you visualized.

This section explains about automatic adjustment of images, adjustment
of brightness/saturation, trimming images, inserting text into images,
adjustment of sharpness, red-eye correction, and cutting movies.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those
described above.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP”). Select the RAW image in the Main Window and select the
[File] menu P [Process RAW Images by Digital Photo Professional],
which will start up DPP. For detailed instructions on using DPP, refer
to “Digital Photo Professional Instruction Manual” (PDF electronic
manual).

Automatic Adjustment Using IB

The brightness and colors, etc. of the image are automatically adjusted.

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Auto Adjustment] in the
menu that appears.

Trim...

Color/Brightness Adjustment...
Red Eye Correction...

Insert Text...

Level Adjustment...

Tone Curve Adjustment...
Sharpness...

Fit to window ':! T T I I

.| =. g

Edit Mumber of Displays Synchronize Full Scree Edit Mumber of Displays  Synchronize Full

J Edit with Registered Application »

Auto Adjustment... )

The [Auto Adjustment] window appears.
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Click the [Auto Adjust Image] button.

Auto

Adjustment window

Auto Adjustment

(( Auto Adjust Image ))

Undo

__| Show Original Image

Cancel )

oK

Display Size

3888 % 2502 | [

The image is adjusted.

Check the adjustments.

_!Show

v Original Image

Display Size:

3888 % 2502

Checkmark to display the image before adjustments

Click the [OK] button.
The [Auto Adjustment] window closes.

Save as a separate image.
In the viewer window, click [Save].

Fit to window B (A
< » |l &a| @ Gl

o Number of
Back Next Save Edit Displays Synchrao|

3888 x 2592 |

The save dialog box appeatrs.

Enter a new name, specify the save location and then
click the [Save] button.

Enter the new name  Specify the save location

066 & IMG_0001,JPG (1/16)

Save As: | IMG_0001 ™

Where: | [l Desktop (B3]
Image Type: [ Exif JPEG M

Fit to window I:] T aTt St A g
4 4 = @ . = = - g

Back Next Save Edit  Number of Displays Synchronize Full Screen Print Show

)
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The edited image is saved as a separate image from the original
image.
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Introduction
Adjusting Color and Brightness Trimming an Image
You can adjust the brightness and color (saturation) of images. You can trim only the part of an image you need, or change the ggﬁt'gn"tfs
composition of an image where an image shot horizontally becomes
Display the image to edit in the viewer window (p.18). vertical.
Basic
. . . i i iti i i Operation
Click [Edit] and then select [Color/Brightness Display the image to edit in the viewer window (p.18).

Adjustment] in the menu that appears (p.27).

The [Color/Brightness Adjustment] window appears. Click [Edit] and then select [Trim Image] in the menu Ad\aced

that appears (p.27). Opggetion

Select the [Color Adjustment] tab sheet and adjust The [Trim Image] window appears.

the image. D he tri i High-Level
Color/Brightness Adjustment window rag p rlmmlng range. Functions
Color/Brightness Adjustment Trl m Im ag ewin d ow
f Trim Image
"RCB Adjustmemll Color Adjustment 9—
. - ;}:;;n;g:x;:: I;eo::-rimmed to the area shown Preferen ces
Saturation ('_'? 0 g
1. Move and resize the trim box in the
rightness = Il preview area.
o s - Using the
C Advanced Options ) Internet
2. Click Trim Image to apply the settings.
_| Show Original Image Undo All Undo Redo N
N = Reference
= = L« Trim Image )
Display Size: 8BS % 2592 ) ’ S il
D t th I ft H ht t d t " = 2, Q‘ 3. Click OK to close the panel. Contents
rag to the left or right to adjus (Fitto window 4] Lookup
Move the slider to the right to make the [Saturation] of an image e =
to appear more vivid and the [Brightness] appear brighter. Move Diplay Sze: 3888 x 2582 [ xm  vas  woan w am ErmT
the slider to the left to make the [Saturation] of an image weaker, Index
and the [Brightness] of an image appears darker. Drag
The image is adjusted. The trimming range can be moved by dragging.
Check the adjustments and then click the [OK] You can change the trimming range by dragging the four corners @ @
button. and the four sides of the trimming range. @

Save the image as a separate image (p.28).
29
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Click the [Trim Image] button. Inserting Text into Images

ick Tri i . , , , Table of
e e You can insert the date and time you shot an image and text into an Contents

image as text.

[C Trim Image )]

Undo Redo Display the image to edit in the viewer window (p.18). Basic
Operation
3. Click OK to close the panel. Click [Edit] and then select [Insert Text] in the menu
The image is trimmed. that appears (p.27). é%@cigﬁ
The [Insert Text] window appears.

Check the trimming and then click the [OK] button.

Drag the range for inserting text. _
. . Insert Text window aloh ol
Save the image as a separate image (p.28). ) — Functions
FontName:  (Genea 19
Font Size: 72
TextColor: | Preferences
Text B
EAmialias
Text; Using the
Internet
| Show Original Image Mhoin;iﬂe”me ) Reference
Undo All Undo Redo
( Cancel ) ( oK ) Contents
Display Size: 3888 x 2592 [ Display: 9% LO 0 ku p
Drag
The text insertion range can be moved by dragging. Index
You can change the text insertion range by dragging the four

corners and the four sides of the text insertion range. —_—

QO
O
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Using the keyboard, enter the text you want to insert.

gAmiaIias

’Tm:r' -~
Import Comment

( Import Shooting Date/Time )

The text you enter appears in the window.

Check your entry and then click the [OK] button.

Save the image as a separate image (p.28).

Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Sharpness] in the menu
that appears (p.27).

The [Sharpness] window appears.

Adjust the image.
Sharpness window

)
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Sharpness

Undo Al Undo Redo

Show Original Image

Displa

( Cancel )6—0&—;

y Size: 3888 x 2592

Drag right to adjust

Move the slider to the right to make an image harder and to the
left to make an image softer.
The image is adjusted.
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Check the adjustments and then click the [OK]
button.

Save the image as a separate image (p.28).

Correcting Red-Eye Automatically

You can automatically detect and correct red-eye that occurs when you
photograph people using a flash.

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Red Eye Correction] in

Introduction

Table of
Contents

Basic
Operation

the menu that appears (p.27). gd%ed
The [Red Eye Correction] window appeatrs. Paa'on
Click the [Start] button. _
Red Eye Correction window HFlgh-L_eveI
o e unctions
E ) N \ (] Mod ' ¢ Start ) '
= Preferences
Using the
Internet
Reference
Contents
Lookup
Frowindow B A &
Dispaay Sine: eIz | :mp:m ' |ndeX

The image is corrected.

Check the corrections and then click the [OK]
button.

Save the image as a separate image (p.28).

QO
O
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Correcting Red-Eye Manually

You can manually correct red-eye that cannot be corrected
automatically.

1 Display the [Red Eye Correction] window (p.32).

2 Select [Manual Mode] and then enlarge the image.

0086 Red Eye Correction
) Aute Mode Start
) Manual Mode
Weak —9— Swang
1 2 3
Surround a red area to specify the area you want to correct
i
oEE 2 WA q
[T Show Original Image  undean )| ( Undo J £ Redo W)
E—caneel—) ¢ OK
Disptay sire: [ muspiay 17 &

Enlarge image display

3 Set the amount of correction.
SManual Mode

Weak v St Drag to the left or right to

' ' adjust
1 2 3

Drag and place a box around the place in the image
you want to correct and then click [OK].

0086 HRed Eye Correction
) Aute Mode Start
® Manual Mode
Weak —a— Strang
1 2 3
Surround a red area to specify the area you want to correct
| (7% WA e
[ Show Original Irhag ( Undoal ) Undo ) Red
€ cameel ) OK
|oisptay iz |:l||u|? I [ spiay T =
Click [OK]

Drag a box on the place to correct
=» The image is corrected.

5 Correct other places in the same way.
6 Check the correction and click the [OK] button.

7 Save as a separate image (p.28).
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Editing Movies
You can edit the movies you have downloaded to your computer in a

number of ways, including joining movies together and adding special
effects such as titles and background music.

®

®

When editing 1920 x 1080 MOV movies with a function other than
“Cutting Movies” (p.38), a temporary file is created for editing and it
may take some time before you can start editing.

Once you have edited movies using these functions, you cannot
play them back on the camera.

You cannot edit MOV movies on a computer with a PowerPC
CPU.

Select the movie.

W imapebiowser Pk D91 View imiemet Window Hein + Twsum @
LYLT:] e Wisiew 3
Pages scquned o o Camers Forra e "]

oy St ) - - - - -

There is a limit on the number of files when you are editing MOV
movies. When you edit 1920 x 1080 MOV movies and save them in
the same image type (format)/size, keep the number of files within
20 files. Similarly, for 1280 x 720 and 640 x 480 MOV movies, keep
it around 25 files.

Select the [Edit] menu P [Movie Edit].

The movie editing window appears.
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Click the tab to select an editing task, and then edit
the movie.

Select the editing task Guidance

806 MovieEdit Task ‘

Arrange images.
1. To arrange images, select the image and click on the [Move Left] or [Move Right] button.
2. Click the [Play] button to play the arranged effects and check them.

3. Click the [Effect] tab to go to Effect Step.

L.Arrange 2. Effect 3.Audio

SR ATETE afe el
Play Add Image Play Time Rotate Move Left ~ Move Right  Properties Clear Enlarge Reduce
L]
. Enlar r movi
Movie icon ages_/ educes movie
thumbnails
Storyboard area* Shows detailed instructions

Transition box (icon for the special effect used in
the transition between joined movies)

* Selected movies are shown as thumbnails. Movies are joined
together sequentially starting from the leftmost movie.

[Arrange] tab sheet functions
Set the playback range for the movie (playback start and end)*
Set rotation or mirroring for the selected movie

Play movies Rearrange the order of the selected movies

fe 0 6 MovieEdit Task

Arrange images.
1. To afrange imaggs, select the image fand click on the [Move Left] or [Move Right] button.
2. Click|the [Play] blitton to play the arrjnged effects and check them.

3. Click|the [Effect] jtab to go to Effect Sjep.

T 3.Audio
g B

Add Image  Play Time Rotate | Mave Left  Move Right

= \@2 Q‘@

Play Properties Clear Enlarge Reduce

L]

Total Time 2:10.0

N

_ Remove the selected
Adds movies to the movie from the storyboard
storyboard area area

Show information for the selected movie

* When a still image is selected in the storyboard area, you can
select the display period for the still image.

|§| When you add to the storyboard area an image with recorded audio

that has been shot with a EOS-1D series camera, the audio is not
automatically attached. Add the audio file in the [Audio] tab sheet on
the next page.
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[Effect] tab sheet functions

Set the effect used in the transition
between movies (transition box)*

Add text to the selected
movie

(866

MovieEdit Task

~

Apply effects to image.

AR
Tk

2.Effect

1 Arrange

L

Play

Text Effect  Filter Effect  Magnify Sec.

You can apply effects to an imagj
image or you have finished apply
1. Apply a Text effect or Filter eff
[Text Effect], [Filter Effect], or [M

9_Annle s Trancition affact to th)

3.Audio 4.5ave

Transition  Properties

B R @ B e o

Clear

2 using the steps shown below. When it is unnecessary to apply effects to an
ing effects, click the [Audic] tab and proceed to the Audio step.

ect to an image. Select the image you want to apply the effect to, click the
agnify Section] buttons, and apply the effect.

imana Salact tha Teancition Effact haw that ic hatunan asch imaann  clicle tha b

R |

Enlarge Reduce

[

Total Time 2:10.0

N

Enlarge part of the selected movie

Convert the selected movie to sepia tone or monochrome

* Select the transition box in the storyboard area and then click
[Transition] to set the effect used.

[Audio] tab sheet functions
Add an audio file to the selected movie*

(6 06 MovieEdit Task |
Add an audio effect.
Use the following steps to add an audio effect to an image. If an audio effect is unnecessary or you have m
finished adding audio effects, click the [Save] tab to go to Save Steps.

. .w' 1. To add audio, click the [Add Audio] button.
2. When you want to arrange the audio clips, select the audio clips you want to arrange and click the [Move
Lnftl o (Menin Richel hurtan ta areanan thans
2.Effect 3.Audio 4, Save
2 o e 'R Q|G
Play Add Audia Advanced Mave Left Mave Right  Properties Clear Enlarge Reduce
z 3
Total Time 2:10.0 A

Adjust the audio volume for the selected movie and set
“Fade-in” (gradually increasing volume) and “Fade-out”
(gradually decreasing volume)

*You can add an MP3, AIFF or WAV audio file as background music
(BGM) or as an effects tone. When you add audio to a movie in this
window, a bar showing the duration of the audio file appears under
the movie’s thumbnail in the storyboard area.

Click the [Save] tab sheet.

WAL LU Al T EITYE LIHE Uiy LD, 2S00 LIS duuiy Ciips y

o Dimht]l haittan ta areanan thons

3.Audio

a =

Move Left Move Right Froperties

|
=
Clear

The [Save] tab sheet appeatrs.
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Click [Save] and specify the required settings
(destination, etc.) in the window that appears. Then
click [Savel].

fe 06 MovieEdit Task

y Save the edit results.
Click [Save] button to save the edit results.

1 Arrange 2.Effect 3.Audic

L

Play

7

Save

@

Save image type : — ) Auto-select
@ Specify a save image type

MOV (H.264) %) ( Advanced Settings...

Save image type : MOV (H.264)
File oV

XXX fps
Hz, 16 bits, Monaural

Set the format of the saved movie
Automatically set the optimal size and frame rate for saved
movies

When an image type is selected in the [Specify a save image
type] list box, clicking the [Advanced Settings] button allows you
to specify the [Image Size], [Frame per Second]* and [Quality]
(sound quality) settings. The [Quality] (sound quality) sampling
frequency for edited MOV movies is fixed at 48 kHz.

* Frame rate : number of frames recorded per second

The edited movie is saved.

Select the [MovieEdit Task] menu P [Quit MovieEdit
Task].

MovieEdit Task

About MovieEdit Task
Preferences... 8,

Services [ 4

Hide MovieEdit Task 3H
Hide Others FEH

Quit Moviekdit Task  #Q

@ If you convert the frame rate of a movie after editing, some scenes
may not playback smoothly.

When [MOV (H.264)] is selected in the [Specify a save image
type] list box in the window in step 5, the movie durations that can
be saved are as shown below.

Movie durations that can be saved

magesie 25 f2p35.9/72%Tg7sf/ps* S e ps

1920 x 1080 Under 10 min. -

1280 x 720 Under 20 min. Under 10 min.
640 x 480 Under 30 min. Under 20 min.
320 x 240 Under 60 min. -

If you attempt to save a movie that is longer than the times shown
above, a message appears. When this happens, shorten the
movie or reduce the image size.

* The frame rates 23.976 fps, 29.97 fps and 59.94 fps are
respectively displayed as 24 fps, 30 fps and 60 fps in the
camera menu.

Saving movies may take some time. Saving movies takes a

particularly long time when [MOV (H.264)] is selected in the

[Specify a save image type] list box.

E.g.) Saving a 1-minute movie with an image size of 1920 x 1080
takes about 7 minutes depending on the system
requirements (p.72).

Time taken to save varies largely with factors including
computer performance and image size, and may take an
even longer time.
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Cutting Movies

You can cut any favorite scene from a movie you have shot.

Double-click the movie you want to play.
Double-click

Click the [Cut Movie] button.

ana B MVILO000.MOV(1/17)

The [Cut Movie] window appears.

Click the [ ® ] button.
Cut Movie window

B
enNnn Cut Movie

S

'46}3 - — - A
-y —— >
10:00.0/0:06.0
Set Time: 0:06.0
( cancel ) Save

=» The movie begins to play.

as the end point.
The movie is cut.

A Drag [ § ] at the position you want to set as the start
point, and drag [ p ] at the position you want to set

)
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Click the [Save] button.

i >

LI

¢t L
0036 /0:06.0

Set Time: 0:02.4

Cancel "__. ( Save

)

The save dialog box appeatrs.

Specify the file name and
click the [Save] button.

save destination and then

Save As:

Where: Documents

&2

|,__' Cancel '_._. { Save )

The cut movie is saved as a separate movie from the original

movie.

Utilizing Your Images

You can view your images as a slide show, send them in an e-mail or
use them as wallpaper or screen savers for your computer.

Viewing Images as a Slide Show

You can display selected images in full screen and switch between them
as a slide show.

Select images.

Select the [View] menu P> [Slide Show Options].

View Mode

View Settings
Sort

Display
Enlarge
Reduce

|l +t v wvwvw

£

View Actual Image
Show AF Frame
Show Shooting Informatior

Slide Show...
( Slide Show Options... )

Refresh #R

The [Slide Show Options] window appears.
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Set the play method and transition effect for the slide
show and then click the [OK] button.

Slide Show Options window

# Slide Show Options )

Play Method
) Auto Play

Play Interval - ISac

b

1 1 1 1 1 1 1 1 1 1
() Control with Mouse or Keypad

1 Repeat Continuously

1 Hides buttons

Transition Effect

" (None) H9

@ t: Cancel \'I[: QK )

The [Slide Show Options] window closes.
Click [SlideShow].

=

5 = & - =

Camera View Image SlideShow CANON IMAGE Frint & Emal
GATEWAY

The Slide Show window appears and the slide show begins.

Slide Show window

Rating setting
Selects the image**

Prints the image*?
Switches to the first image

Switches to the previous image —

t IIEnds the slide show

Switches to the last
image

—— Switches to the next
image

Pauses the slide
show

1 The image is selected. When the slide show ends and returns to
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and
returns to the main window, the print dialog box is displayed.

When all the images have been displayed, the Slide Show
window closes and returns to the main window.
To end the slide show half-way through, click [ & 1.
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Introduction

Select [Using the recommended settings.] and then
click the [Finish] button. Table of

Sending an Image by E-Mail

You can attach a selected image to an e-mail and send it. N Contents
. . L Create Image for Email window
The attached image to be sent is a copy of the original image and Ty
therefore the original image remains unaffected on your computer. . o
the total file size of BaSIC
. (8 Using the recommended set(ings.) attachments be limited N
Select an image. e e Operation
Custom Settings g:‘e:a’:ieozz‘t::uw,
. . . -Reduce the number of
Click [Print & Email] and then select [Create Image ST = Ad%ed
for Email] in the menu that appears. Z'Z“F Opggiion
High-Level
Functions

—— A &[[ e

- -

ANON IMAGE Print & Email Send to Trash = == =
GATEWAY ( Cancel ) " Finish " Preferen ces

The image is displayed in the main window and the e-mail

v software starts up.

® Attach to the e-mail [Email Images] in the folder area and then Ulﬁltg?ntgte
send the e-mail.
Photo Print...
Index Print...
Layout Print... Reference
Create Image for Email...
FANGN |Ma;E Print & Email Send to Trash
Contents
The [Create Image for Email] window appears. Lookup
Index

-

Q0
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Creating Wallpaper from an Image

You can make a selected image wallpaper for your computer.
The JPEG image for the wallpaper (extension “.JPG”) is created using a
copy of an image and therefore the original image remains unaffected.

Select an image.

Select the [File] menu P> [Export Image].

The [Write a still image] window appears.

Select [Export an Image as Wallpaper] and then click

the [Next] button.
Write a still image window

Write a still image

@ Edit and Save Image

Converts images to a different image type or changes the size.
Movie images or RAW images cannot be exported.

() Export Shooting Properties
Exports the Shooting properties of the selected image to a file.

(") Export as a Screensaver

Creates a screen saver from the image.
Mavie images and RAW images cannot be exported.

(O Export an Image as Wallpaper]

The image will be made so you can use it as Wallpaper.
Maovie images and RAW images cannot be used as Wallpaper.

The [Set Image as Wallpaper] window appears.

From the list box, select the wallpaper display

method and then click the [Finish] button.
Set Image as Wallpaper window

Set Image as Wallpaper

Sets the image as Wallpaper

Specify Display Method [ Fit to Screen | :!)

( cancel ) ( <Back ) ( Finish )

The image you selected for your wallpaper is applied as

wallpaper.
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? To revert to the original wallpaper

On the desktop, launch [System Preferences] from the Dock and then
click [Desktop & Screen Saver].
Select the [Desktop] tab sheet.

Select the file for the wallpaper and then click [ £3 ] to close the dialog
box.

Creating a Screen Saver from an Image

You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SLIDESAVER”) is created
using a copy of an image and therefore the original image remains
unaffected.

Select an image.

Select the [File] menu P [Export Image].

The [Write a still image] window appears.
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)

Introduction

Select [Export as a Screensaver] and then click the Specify the saved screen saver on your computer.
[Next] button. On the desktop, launch [System Preferences] from the Dock and Table of
The [Export as a Screensaver] window appears. then click [Desktop & Screen Saver] P> [Screen Saver] tab sheet Contents
. . to display the [Screen Saver] tab sheet.
Using the keyboard, enter a name and then click the 555 Play the | Deskmp&sﬂee“iﬂ

[Finish] button. a Basic

Operation

Export as a Screensaver window

{ Desktop | Screen Saver }

(@06 Export as a Screensaver “ Screen Savers Preview
T rorest -
The selected image will be exported as a screen saver. Je3) iTunas Artwork Adv _ed
’a Nature Patterns Op 10N
@ Paper Shadow
Mame of Screen Saver & RSs Visualizer
IB_ScreenSavers ;; ?:I:ztmm High-LeveI
,-_j Pictures Folder Functions
Save To L—j Choose Folder
Macintosh HD:Users:canon:Library:Screen Savers B G ):I
" Use randofm screen saver ( Options... ) ( Test ) Preferen ces
[ Cancel ) [ <Back ) ( Finish ) . =
= Start screen gaver: ; ‘ o ; ; ;
The screen saver data is saved in the [Screen Savers] folder Coon o
: { HotCor'nerD @ Using the
Internet
Select the saved screen saver data
Close the [Desktop & Screen Saver] window. Reference
Click [ #% ] on the top left of the dialog box.
Contents
Lookup
Index
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. : . 1 1 Introduction
Printing Multiple Images on One Sheet of Paper (Index Printing)
You can arrange multiple images in index format and print them on one Specify settings such as the paper type and the
sheet of paper. number of prints, and then click the [Print] button. Table of
Select the | Index Print window Contents
elec € Imag es. CREGE Index Print )
Printer Preview Bas | c
Click the [Print & Email] button and then select Naare: ) | ! Operation
. Canon XXX e ! [ E
[Index Print] from the menu that appears. —— |—‘ )
Paper size : i
- ; Ad\aced
Photo Print... : : = i Op ion
: = ( Index Prir.n... ) | Orientation: Portrait i
—o—— & & —t e P e =
V.| B, 3 @ . E—— R G ; High-Level
xgﬂorluwmﬂﬁcs Print & Email Send to Trash Jgf_&:\mﬂs Print & Email Send ta Trash E Fu n Ct| ons
Copies: | A i1l z "_"
The [Index Print] window appears. i |
Rows: 3 3 Preferences
Columns: 2. L
Page Caption Settings — e
gShoming Information @ Gos L4 ‘\t/l h
Settings... ) . = USing the
) Header | Footer — § ‘§ E—j Internet
e — Rotate Left Rotate Right Trim Image
( Close )'( Print )'/
Reference
Print preview
Printing begins. Contents
Lookup
Index

QO
O

@ For a list of index print window functions, refer to p.78.



Arranging Images Freely and Printing (Layout Printing)

You can lay out images freely and then print them.

Select the images.

Click the [Print & Email] butto

n and then select

[Layout Print] from the menu that appears.

Send to Trash

Print & Email

pMON IMAGE
GATEWAY

The [Layout Print] window appears.

Photo Print...

Layout Print...
Create Image for Email...

%v W

EANON IMAGE Print & Email Send to Trash
GATEWAY

Lay out your images by dragging them and then click
the [Print] button.

Layout Print window
(@06

Layout Print

Print Style Preview

Custom layout printing F'H

Printer —

Name:

" Canon Xxx }-ﬁ
( Page setup... )

Paper size :
A4

Orientation: Portrait

Click [Page Setup] to enable
borderless printing on supported
printers.

& R

Rotate Left Rotafe Right

R = w=
Sl -‘ f om

Trim Image Images Re-Layout Clear
per Page

( Close ) ( Save 1( Print ))#

Print preview

Printing begins.

@ For a list of layout print window functions, refer to p.79.
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3 High-Level Functions

EER

i

Comparing Multiple Images.........c..cccevvvviivievveennnnnn. 48
Viewing Shooting Information for an Image............. 49
Changing the Size and Type of an Image and
SAVING ot 49
Exporting Shooting Information ..............ccccceeeeeeees 50
Extracting Still Images from a Movie ....................... 51
Organizing Images Using High-Level Functions ..... 53
Setting Keywords in Images.........ccovvveiiiieeiieeeiiiinnnnnn. 53
Entering Comments into IMages ............cceeevveeeeeeeennnns 53
Saving Multiple Images with New File Names............ o4
Classifying Images by Shot Date............ccccvvvvvvvvnnnnnes o4
Searching for Images .......cccoovvvviiiiiiveeiccie e, 56
Performing Advanced Editing..............cccevviiiieennnnn. 57
Adjusting the Color of an Image in RGB.................... o7
Adjusting the Brightness Level ...........ccccoveviiiiiinnennn. 58
Adjusting the Tone CUurve........cccccceeeeeeeeiveeeiiiceee e 58
Transferring Images to Other Image Editing Software... 59
Merging Images to Create Panorama Images............ 60
Adding Sound to Images/Playing Back ................... 61
Adding Sound to IMages .........ccvvvviiiieeiiiieeiiiee e 61
Playing Back Sound .............cceeiiiiiiiiiciiiiii e 61
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Comparing Multiple Images

To compare multiple images, you can split the viewer window into two,
three or four and display multiple images at the same time.

You can also align the display position of enlarged images and compare.

In the main window, select the images you want to
compare (p.10).

Click [ =] (View Image) (p.74).
The viewer window appears.

Click [Number of Displays] and select the number of
iImages you want to display at the same time.

. v’ Single View
2-Page View (Arrange horizontally)
2-Page View (Arrange vertically)

T — T UL R VY - 3-Page View
fowindor— T v ev s 1 4-page view
Por =
B3] =. | & =

Edit Mumber of Displays §Synchronize Full Screen Number of Displays Synchronize Full Screen

i

Click [Synchr

! " Fit to window Hj)l:!r e AR AR ¢

onize] and then enlarge the image.

el -
er of Displays § Synchronize Full Screen Print Show
Information
[ Disnlaw_ 10
Click Select the display magnification

The viewer window is split and the multiple images are displayed
at the same time.

v

Example of display when [4-Page View] is selected

anea L pictures
IMG_0101JPG {1/4}

IMGC.0102 JPG (2/4)

Fit 80 windcw W i

0"
i
&

o

The synchronize display appears and all the images are displayed
at the same display magnification and in the same position.

The navigator window that displays the enlargement display
position appears and you can check and move the enlargement
display position (p.19).
Click [Synchronize] again to cancel the synchronize display. You
can now change the display magnification and move the
enlargement display position for each image.

To return to full view, select [Fit to window] from the list box under

each image.

To cancel the split display, click [Number of Displays] at the bottom of
the window and then select [Single View] from the menu that appears.
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Viewing Shooting Information for an Image
Display List Mode (p.74).

Select the image for which you want to view the
information.

Select the [File] menu P [Get Info].
The [File Information] window appears.

Click the [Advanced View] button.

( )

v

8ens File Information

¥ Rating / My Category 'F

R S G e ¢

¥ Comment

¥ Keyword

( View/Modify Keywords... )

¥ Brightness Histogram I

k Hicle Detail )
File Name: IMG_0001
Madified: XXX SHHRR KHXAKXK
File Size: 7 MB (7,353,855 Bytes)
Image Size: 3888 x 2592 ¥ Shaoting Informatien
Data Type: PG i
- value v
Sound: IME_0001FC
Lock: et ame el Canon EOS XXX
! oting DateTim XX /XK /XX XX XXXX
= = = = Tvi Shutter Speed } 1/500 et
{ <Back 9 | o s Avi Aperture Value 56 v

|§| In Preview Mode, the same information as the [File Information]
window is displayed on the information display area (p.73).

Changing the Size and Type of an Image and Saving

You can change the size of an image or convert it to a TIFF image
(extension “.TIFF") or a PICT image (extension “.PCT”) and save it.
Because the image is saved as a separate image, the original image
remains unaffected.

Select an image.

Select the [File] menu P [Export Image].
The [Write a still image] window appears.

Select [Edit and Save Image] and then click the
[Next] button.

Write a still image

(8 Edit and Save Image]

Converts images to a different image type or changes the size.
Movie images or RAW images cannot be exported.

() Export Shooting Properties
Exports the Shooting properties of the selected image to a file.

—
([_) Export as a Screensaver

Creates a screen saver from the image.
Maovie images and RAW images cannot be exported.

() Export an Image as Wallpaper

The image will be made so you can use it as Wallpaper.
Movie images and RAW images cannot be used as Wallpaper.

o (D)

The [Edit and Save Image] window appears.
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Exporting Shooting Information

Specify the image size, type, file name and save You can export as a text file the shooting information recorded to the
destination, and then click the [Finish] button. image.
Edit and Save Image ) .
"I Resize the image SeleCt an Image'
+) Specify the length dimension 3688 FES'S
,Chgh‘mg”yp Select the [File] menu P [Export Image].
- — o - The [Write a still image] window appears.
Image Quality Low f\_/‘ ligh . . .
2 Rename the fie Select [Export Shooting Properties] and then click
niial text . the [Next] button.
NEW Sequence number is assigned automatically The [Export Shootlng PrOpertIeS] WlndOW appears
Example: NEW0OOQL1JPG
S— Specify the export shooting information, the file
riginal e S1Ze: - . . .
File size after compression: P name, and the save destination, and then click the
Save To:MacOSX Users:canon:Pictures:xxxx_xx_xx:xxxx_xx_01 (" Browse.. ) [F|n|Sh] button.
— = (@06 Export Shooting Properties ")
Cancel B < Back ] ( Finish )
Select the image info to be written.

Creates a text file in which item names and values are tab-delimited.

The image is saved as an image separate from the original
image' ' File Name m

] camera Model

1= Shooting Date/Time
| Shooting Mode

[ photo Effect Mode
[ Tu(Shutter Spead)
[ AviAperture Value)
] Metering Mode

; Exposure Compensation ]
_ Digital Exposure Compensation v
- ~ -
( Select All ) Deselect All )
File Name
Save To: Macintosh HD:..._1000:xxx_100 | Browse... )

A single file is created for 10 images.
The file name is given a sequence number.

( Cancel ) ( < Back \'Il Finish '

P

The shooting information is saved as a text file (extension
“TXT").
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Extracting Still Images from a Movie

You can extract still images from a movie and save them as image files.

® When extracting still images from 1920 x 1080 MOV movies, a
temporary file is created for editing and it may take some time
before you can extract still images.

Select the movie.

[ imagedrowser Fie @
Bnn

g cpsee o pour camers
e sccemeed

o ot

s =T IR R memm— e
Select the [Edit] menu P> [Extract frames from a movie].

The [Settings] tab sheet for [MovieFrame Task] appears.

Set the extraction method and click the [Preview] tab
sheet.

806 MovieFrame Task

\Sel the Extraction Method.
1. Select how you want to extract still images from a movie.
2. Click the [2. Preview] tab and move on to the next step.

@ Extract all frames

% Extracts every frame in the mavie as a still image.

() Specify an interval and extract frames

% Specifies the interval at which still images are extracted from the movie.
Frames 2

File Name:MV1_5471.MOV. ) Specify the number of copies and extract frames
Play Time:00:18.26 % Specifies the number of capies of still images to be extracted from the movie

| Total Frames 548
Image Size
Copies

‘ ) Extract a specified image

-+
% Extracts the frame you select while watching a preview of the movie as a still image.
1

L

@ [Extract all frames]
This option extracts all the frames in a movie as still images.
[Specify an interval and extract frames]
This option extracts still images from a movie at intervals of a set
number of frames or seconds.
[Specify the number of copies and extract frames]
This option extracts a specified number of still images from the
frames of a movie. The interval at which each of the specified
number of images is extracted is calculated evenly across the
movie's number of frames.
[Extract a specified image]
This option extracts a still image of a scene of your choice during
movie playback.
The [Preview] tab sheet appears.

)
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Check the extracted images and click the [Save] tab

sheet.
When [Extract a specified image] is selected in step 3, you can
play the movie on the left of the window and extract an image by
clicking [ ] when you reach a scene you like.

Rotate all the images
Add/remove all the check marks
Resize the thumbnails

r6 06 MovieFrame Tafk

review images.
. Confirm the images to be saved. Images that arg checked will be saved.
. Click the [3. Save] tab and move on to the next step.

LE]' Wiv) EE ,
] (5[] o —O——pa @
Check all Clear all J\ Clear previous Clear next)

Rotate Thumbnail size

Checked: 1800 rsmuM

Pl * P N {
' » O Tan[en '
File Name MVI_54 74 MOV

Play Time:01:00.00
Total Frames: 1800
Image Size:

P

Remove the check mark from the images
before and after the selected image

Playback/pause, frame back,
frame forward, half-speed
playback, double-speed playback

Save the images with
check marks

The [Save] tab sheet appears.

)

Introduction
Click [Save] and specify the required settings
(destination, etc.) in the window that appears. Then Table of
click [Choose]. Contents
(@06 MovieFrame Task )
\Save still images. _ ( ] )
; i?:(rehzog:vi? gjt?;:h:alzxi?::t(tehsasts\ﬁ\:err?a.ge(s] from the movie and save. BaSIC
Operation

1. Settings 2. Praview

% Advanced

. ‘ © Operation

Saved images: 548
Required Disk Space: Approx. 328.4 MB

File name:
@ Use original movie file name
) specify a file name

Example: MVI_5471_0001.jpg

File Name:MVI_5471.MOV
Play Time:00:18.26 Aute folder creation:

Total Frames:548 ‘

@ Automatically create a folder with the same name as the original movie
) specify folder name

Image Size:

AJ

=» Still image extraction begins.

P

Select the [MovieFrame Task] menu P [Quit
MovieFrame Task].
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Organizing Images Using High-Level Functions

You can organize images using high-level functions such as setting
keywords and entering comments, renaming multiple files in a single
operation and classifying images by shot year/month/date, all of which
are useful when organizing your images.

Setting Keywords in Images

You can set keywords to identify images. The set keywords are also
useful when searching for images (p.56).

Select an image.

Select the [Edit] menu P [Keyword] P> [Settings].
The [Keywords Setting] window appears.

Select the keyword(s) and then click the [OK] button.

fa an Keywords Setting
People Places Events Others
O Family 1 Home O party
! Children [ Beach ! Holiday
O Friends J city [ Birthday

Check or uncheck the boxes to change the way Keywords are applied to the selected images. To
add a new Keyword to the system, type the name in the text field below the desired category, and
press the [+] button.

( cancel A ( 0K )

The keyword is set in the image.

Entering Comments into Images

You can enter information relating to images as comments. The entered
comments are also useful when searching for images (p.56).

Display the [File Information] window (p.49).

Click the [Advanced View] button.
A field for entering comments is displayed.

Enter text and then press the <return > key on the

keyboard.

8066 File Information ]

Introduction
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Operation

¥ Rating / My Categary M
w Comment
Preferences
¥ Keyword
( View/Modify Keywords... ) Us|ng the
[T ———— Internet
4 Hide Detail 3
File Name: IMG_0001
Modified: XK TXRKR HRXHXK |
File Size: 7 ME (7,353,855 Bytes) D Reference
Image Size: 3888 x 2592 | ¥ shooting Information
Data Type PG | U
Itern Mame Walue
Saund: IMG_000 1 JFG
Lock: m | 101 ‘Canon EQS XXX m
. g Date Tim XX/ XX /30X 300300 XK Contents
eed ) 1/500 d
( <Back ) (" Next > ) Aol Apenure::za\ue 5.6 Y LOOkU p
A
The entered text is saved in the image.
Index




Saving Multiple Images with New File Names

You can copy multiple images and save them with new file names in a
single operation.

Select all the images you want to save with new file
names (p.10).

Select the [File] menu P> [Organize Image] P
[Rename].
The [Rename] window appears.

Enter the file name and click the [OK] button.

r ™y
Rename

Select the post-conversion file name type.
il Copy Image
@ MNew Name + Mumber
") Shooting Date + Number

S Mew Name + Shooting Date + NMumber

C Shooting Date + New Name + Number

New Mame: [ ]

Number:
Specify Number of Digits 3 2
Specify a Start Number 1

Example:

_001.xxx

(The same extension as the original is entered in xxx)

Images separate from the original images are saved with the new
names.

Classifying Images by Shot Date

Multiple images can be classified into different folders according to shot
date.

Select all the images to be classified (p.10).

Select the [File] menu P [Organize Image] P [Sort
Images].
The [Sort Images] window appears.

Select [The files will be separated into folders for

each shooting date.] and then click the [Next] button.

e “
Sort Images

Select the sort method for the selected image's folder.

(e The files will be separated into folders for each shooting date. ]

() The files will be organized by Star Rating.

The [Organize by Shooting Date] window appears.
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Specify the folder structure, the file names, and the
save destination, and then click the [OK] button.

-

Organize by Shooting Date

-~

The files will be separated into folders for each shooting date.

Save To:

A new folder will be created in this folder.
MacOSX Users:canon:Pictures:xxxx_xx_ocxx... [ Browse... )
e e e+

Sort Folder Settings:

Based on the following settings, a new folder is created, and
the images are sorted by each of their shooting dates.

Folder Name: " YearMonthDate | :]

New Name: ] € Edit... )

MacOSk:Users:canon:Pictures:

OO 04 00000 ok _01:2006_12_12

Copy/Move Images Setting

® Copy

~
_ Move

( cancel ) ( <Back J|( oK )

Images are classified by shot date.

Settings for Folder Structure

Setting Item
YearMonthDate

Year/YearMonthDate

Year/Month/
YearMonthDate

Year/NewName

NewName/
YearMonthDate

YearMonthDate/
NewName

Description

Classifies images by creating a first-level folder
according to shot year/month/date.

Classifies images by creating a second-level
folder for the shot year, and the month and date.

Classifies images by creating a third-level folder
for the shot year, the month, and the date.

Classifies images by creating a new folder with a
new name inside the shot year folders.

Classifies images by creating folders for shot

year/month/date inside a folder with a new name.

Classifies images by creating a new folder with a
new name inside the shot year/month/date
folders.
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Searching for Images

You can search for images by ratings (p.19), shot date, comments (p.53)
and keywords (p.53).

Select the [File] menu P> [Search].
The [Set Search Criteria] window appears.

Specify the search criteria and then click the [Search
Now] button.

(f_\ O Set Search Criteria A
Specify Search Folder:MacOSX:Users:canon:Pictures:ooo_xx_01
@ Match all conditions C Match any conditions
»  [Rating
» [Date
> Keyword

» ] Comment

Cancel ( Search Now ]

The search begins and the images that match the criteria are
displayed in the [Search Results] window.

Click the [Finish] button to close the [Search
Results] window.
The display returns to the main window.

Check the searched images in the main window.
The searched images are displayed in the main window. Also,
the [Search Results] folder is displayed in the folder area, and by
selecting this folder, you can display the searched images at any
time.

@ ImageBrewser File  Edt View  Intermet  Window Help
6606 L Browser Window

P08 BoQUIED OM YOU Camera Feves Mode [ U abede-
£an be acorssad heve.

4 TueS1iPM O

| Favorite Foldens | il Faiders

Sk search Results

¥ Pures NG_0001JPG
D .
i e

ING_000% JPT

G, 0006.IPG

NG 0014 PG NG 0015 576

Add.

o A Sgad Aaad 8 ) Vot 04 magin

The images inside the [Search Results] folder are stored until
you either perform another search or quit IB.

Any work you do on images inside the [Search Results] folder will
be applied to all the original images. Therefore, please be aware
that if you edit or delete images inside the [Search Results]
folders, the original images will be edited or deleted also.

)

Introduction

Table of
Contents

Basic
Operation

Advanced
Operation

Preferences

Using the
Internet

Reference

Contents
Lookup

Index

-

QO
O

56



Performing Advanced Editing

This section explains image editing using high-level functions based on
the assumption that you are familiar with handling standard image
editing software.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP”). Select the RAW image in the Main Window and select the
[File] menu P [Process RAW Images by Digital Photo Professional],
which will start up DPP. For detailed instructions on using DPP, refer
to “Digital Photo Professional Instruction Manual” (PDF electronic
manual).

Adjusting the Color of an Image in RGB

You can adjust the color of an image in RGB (red, green, blue).

Display the image to edit in the viewer window (p.18).

Click [Edit] and then select [Color/Brightness
Adjustment] in the menu that appears (p.27).
The [Color/Brightness Adjustment] window appears.

Select the [RGB Adjustment] tab sheet and adjust
the image.

Color/Brightness Adjustment

Show Original Image

'{ RGB Adjustment IICa\ar Adjustment

Green

Undo Al

Redo

Display Size:

3888 x 2592

Cancel

) o)

A

»The image is adjusted.

Drag to the left or right to adjust

Check the adjustments and then click the [OK]

button.

+ Save the image as a separate image (p.28).
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Introduction
Adjusting the Brightness Level Adjusting the Tone Curve
You can adjust the level of brightness (balance). You can adjust the brightness, contrast and color of a specific area by ggﬁt'gn"tfs
changing the tone curve.
Display the image to edit in the viewer window (p.18).
Display the image to edit in the viewer window (p.18). OBasic_:

. . . . peration

Click [Edit] and then select [Level Adjustment] in the
menu that appears (p.27). Click [Edit] and then select [Tone Curve Adjustment]
The [Level Adjustment] window appears. in the menu that appears (p.27). gdvant(_:ed
The [Tone Curve Adjustment] window appears. peration

Adjust the image.

Level Adjustment

Adjust the image.

(rce_ & ( Autolevels ) Tone Curve Adjustment Hig ;VEI
Input Levels 0|— W T EPrevlaw RGB I o FUﬂC nS
Output:
Preferences
— Using the
do 4 Und N Redo o Internet
@D R | Show Original Image Undo All Undo Redo
3888 x 2592 | |
Drag right to adjust Drag left to adjust e K|C—') - Reference
Drag to the left or right to adjust
The image is adjusted. Click to add a [ W] (point) EaTEn S
_ . Adjust by dragging [l ] Lookup
Check the adjustments and then click the [OK] . .
button The image is adjusted.
' The horizontal axis shows the input level and the vertical axis
Save as a separate image (p.28). shows the output level. Index
The maximum number of [l ] is 10.

To delete a [H ], press the < delete > key on the keyboard.



Introduction

Check the adjustments and then click the [OK]

Transferring Images to Other Image Editing Software

button. . . . Table of
You can transfer images to image editing software other than IB. Contents
Save as a separate image (p.28).
In the main window, select the [ImageBrowser] menu
» [Preferences]. Basic
. Operation
The [Preferences] window appears.
From the menu, select [Register Application] and Ad d
then click the [Add] button. Operation

The [Application Selection] window appears.

Select the image editing software to transfer to, and HigMevel
then click the [Open] button Fugns
The selected software is registered.
A Click the [OK] button and then close the
. Preferences
[Preferences] window.
~ Select the image you want to transfer to the image
it Using the
editing software. ey
Select the [Edit] menu P> [Edit with Registered
““ Application] P> image editing software to transfer to.
The selected image editing software starts up and then image is Reference
displayed.
Contents
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Index
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Merging Images to Create Panorama Images

You can merge up to four JPEG images to create panorama images.
For merging images, start up the image-merging software “PhotoStitch”
from IB and use.

1 Select multiple images to merge (p.10).

Select the [Edit] menu P [PhotoStitch].
=» PhotoStitch starts up and the main window appeatrs.

Check the arrangement of the images to be merged

and click the [2. Merge] tab sheet.

@ If the arrangement of the images to be merged is not correct,
drag the images to rearrange them.

(@006

Photostitch ]

Merge Images Shot in Stitch Assist Mode
Click [2. Merge] to merge these images.
For images shot as a 360-degree panorama, click [Arrange], select )
[360 Degrees] and then click [2. Merge].

1. Selection and Arrangement | 2. Merge

+)

Enlarge

STITCHO1.JPG

STITCHOZ.JPG STITCHO3.JPG STITCHO4.JPG

4|kl

No. of Images: 4

1024 3 768 True Calor )

=» The window switches to the [2. Merge] tab sheet.

4

Click [Start] to merge.

(@06

PhotoStitch

STITCHOT.JPG

Merge Images

Click [Start] to begin merging.

1. Selection and Arrangement | 2. Merge
=

+)

Enlarge

STITCHOZ.JPG STITCHO3.JPG

I f

STITCHO4.JPG

MNo. of Images : 4

Panning (Scenery, ete.)

Focal Length: Auto Acquire - Canon |

=» The images are merged and displayed.

Click the [3. Save] tab sheet.
=» The display switches to the [3. Save] tab sheet.

G
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I I Introduction
Adding Sound to Images/Playing Back
Check the save range and then click [Save]. You can add sound to images and play back sound which you have
(@00 e ) added to images with a camera that has a sound record function. Table of
Save Image Contents
Click [Save] to save.the merged image. To merge a different image, .
;E”EI..IFH to [1. Selection and Arrangement], click [Clear] and then [Clear Ad d I n g SO u n d to Im ag es :
You can add a sound file to an image. OpBe?zlt(i:on
e ( A Mac OS X function is used for sound recording. When inputting sound
. Selection and Arrangement | 2. Merge Rk .
from external equipment, connect the external equipment to your
= £ - : computer beforehand. Advanced
‘ adjust Image. .. Enlarge Operation

Select an image to which you want to add sound.

] High-Bevel
Select the [File] menu P [Sound] P [Record]. Fur:;ns
The audio recording dialog box appears.

» Click [ ®] (recording button) and begin recording the - A
Sl T sound to be added to the image. Click the [Save]
. button to stop recording.
ave range =» The recorded sound file is added to the image. The [E,EI ]iconis ;
' Using the
Drag [ W ] to change the range displayed in the image to which the sound file was added. Integr]net

The [Save As] dialog box appears.

Specify the save destination and then click the _
[Save] button. Playing Back Sound Reference

The merged images are saved.

You can play back sound files that are attached to images.
Select the [PhotoStitch] menu P [Quit PhotoStitch]. EaTEn S
PhotoStitch quits. Select an image to which a[[J{] icon is attached. Lookup

Select the [File] menu P [Sound] P> [Play].

The sound is played back. Index
|§| See also the Help that are displayed when you click[ ] on the
right of the window for information on operating PhotoStitch and

PhotoStitch functions.
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Preferences Introduction
You can change any of the IB functions in the preferences window. : :
Check the settings displayed for each window before making changes. Browser Window Setti ngs Table of
You can change the background color of the main window (browser Contents
Select the [ImageBrowser] menu [ 2 [Preferences]. window) as well as the color of the thumbnail image frames.
You can also make settings for color management.
. Basic
F_rom the menu, select th_e dialog box you_want to S . Operation
display, specify your settings, and then click the — -
[OK] button. Color 5cheme
e M| Thumbnail Area Preview Area édvantqed
. = = Frame Color |:| Background Color |:| pera jen
( Browser Window 4 !) AT I:l
R Background Color I:l
Thumbnail Area Preview Area ngh‘LeVeI
Frame Color = Background Color | Customlcon & & o Functions
Selection Color [=——=] " Create Custom lcon for Images
Background Color l:l Coler Management N
[ Adjust Image Colars Using a Monitar Profile
[_| Create Custom lcon for Images ® Preiﬁ ces
"] Adjust Image Colors Using a Monitor Profile ( S— ( i )

® Using the
Internet

( Cancel \'\( OK )
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Introduction
Viewer Window Settings Confirmation Dialog Box Settings
L . . . . . . . . . Table of
You can set the shooting information displayed in the viewer window You can set the software so that confirmation dialog boxes displayed Contents
(p.75). after each operation are not displayed.
The items you uncheck are not displayed.
Preferences BaSIC
[ viewer Window 4 Preferences Operat|0n
Select the shooting information you want to be displayed in the Viewer Window. { Confirmation Dialog Box [4]
I—: PlleName Display a message dialog box in the following cases
|__ Camera Model Advanced
"] shooting Date/Time Operatio n
Il Shooting Mode ™ When placing a folder in the trash
] Photo Effect Mode o
E L # When a search results folder is displayed
™ Av(Aperture Value) ™ When filter settings have been changed .
") Metering Mode & ; o ng h‘l_.evel
# Exposure Compensation When carrying out RAW development with Viewer Fu I’lCtI ons
[ Digital Exposure Compensation i # When playing a movie containing rotation information
[ Autoexposure Bracketing Y
€ Select All 3 £ Deselect All )
Pref ces
( Cancel ;l ( 0K )

( Cancel :J E—S‘(—a

Using the
Internet

Reference

Contents
Lookup

Index

? To display the shooting information in the viewer window @ @
In the viewer window, click the [Show Shooting Information] button @
(p.75) and in the menu that appears, select [Show Shooting Information] —~

to display the shooting information. 64



Introduction
Processing When Rotating Settings Photo Print Settings
. . . - . . . Table of
You can make settings related to image rotation. When printing with the [Photo Print] window (p.16), you can set whether Contents
to trim the image and print with no borders around the paper, or to print
Preferences as |S WIthOUt tl’lmmlng
| Processing When Rotating | :i Ba.sig
Preferences Operat'on
Rotation process when a JPEG image is downloaded from a camera
' Photo Print A
) Rotate an original JPEG image
A JPEG image that was rotated in the camera contains rotation information in the shooting Trimming Setinge Advan Ced
information. Operat|0n
® Automatically trim to remove extra white space
) Do not trim
However, if an image has original decision data appended, the actual image will not be
rotated. -
“ High-Level
Functions
( Cancel ) ( 0K ) Preiﬁces

( Cancel ) ( oK )

. . Using the
Layout Print Settings Internet

You can make settings for layout printing.

Register Application Settings

e — You can register other editing software. Reference
["Layout Print 9

Item to print in caption Preferences

[_| Shooting Date .

) Shooting Time Register Application 4 j CLC:)nOtES:)S
|__ File Name A registered application can be run using [Edit with Registered Application] in the [Edit]
Length menu.

"inch [ ]

Index

-

(: Cancel ) f ) :
Delete ) ( Add.. )

( Cancel ) ( OK )
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Using CANON IMAGE GATEWAY

CANON iIMAGE GATEWAY is a free Internet online service restricted to
users who have purchased a Canon digital camera (no membership or
annual fee).

To connect to CANON iIMAGE GATEWAY, it is necessary to register as a
member beforehand. Insert the EOS DIGITAL Solution Disk provided
into your computer and perform registration in the CANON iMAGE
GATEWAY member registration window that appears after installing the
software that includes IB. You can also use the following procedure to
register as a member.

For detailed information on CANON iMAGE GATEWAY, refer to the
CANON iIMAGE GATEWAY Help.

Membership Registration

You can register as a member of CANON iMAGE GATEWAY.
When you have finished registering, you can also change the
connection information or add cameras.

Register as a member.
Click [CANON iMAGE GATEWAY] and in the menu that appears,
select [Register/Add Product].

Register/Add Product

Top Page

e Q @ = =l = Upload Images 1 =
AR = Ee Y View Online Photo Album

@.) B 8 e

[CANON IMAGE Print & Email Send to Trash CANON IMAGE Print & Email Send to Trash
GATEWAY GATEWAY

The [Register/Add Product] dialog box appears.

Click the [Register] button.
The browser software starts up and the CANON iMAGE
GATEWAY membership registration page is displayed.
Perform membership registration by following the on-screen
instructions.
When you have finished registering, you can also change the
connection information or add cameras.

Displaying the Top Page of CANON iIMAGE GATEWAY

The CANON iIMAGE GATEWAY top page is displayed with the browser
software.

Connect to the top page.
Click [CANON iMAGE GATEWAY] and in the menu that appears,
select [Top Page].

Register/Add Product
Top Page

Upload Images 13
View Online Photo Album

2] B\ @ —_g——
& T .. - ="
[CANON IMAGE Print & Email Send to Trash CANON IMAGE Print & Email Send to Trash
GATEWAY GATEWAY

2 The [Enter registration information.] dialog box appears.

— @ _5e|e;tir\_glm.1gei v = =

Enter your user name and password and then click

the [OK] button.

=» When the connection dialog box is displayed and connection is
completed, the browser software starts up and the top page of
CANON iIMAGE GATEWAY is displayed.
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Uploading Images in a CANON iMAGE GATEWAY Album

You can upload images selected in IB in a CANON iMAGE GATEWAY
Online photo album. You can also show images in a registered album to
specified people.

The images uploaded in an album are copies, so the original images
remain unaffected on your computer.

Select images to be uploaded in an album.

Connect to CANON iMAGE GATEWAY.
Click [CANON iMAGE GATEWAY] and in the menu that appears,
select [Upload Images].

Register/Add Product
Top Page

Q @ == e = = = Upload Images 13 2
. . et || View Online Photo Album y”
?| 2 B . TR

[CANON IMAGE Print & Email Send to Trash CANON IMAGE Print & Email Send to Trash
GATEWAY GATEWAY

Upload the images selected in step 1 to a new album
by following the on-screen instructions.

Displaying a Registered CANON iIMAGE GATEWAY Album

You can display images that have been uploaded in a CANON iMAGE
GATEWAY Online photo album with the browser software.

Display an album.
Click [CANON iMAGE GATEWAY] and in the menu that appears,
select [View Online Photo Album].

Register/Add Product
Top Page

= 5'1'} I" T | 3 = Upload Images | =
o & € v ‘View Online PhnmAIbum’

é - - . = ==
[CANON IMAGE Print & Email Send to Trash CANON IMAGE Print & Email Send to Trash
GATEWAY GATEWAY

< The [Enter registration information.] dialog box appears.

Enter your user name and password and then click
“ the [OK] button.
=» When the connection dialog box is displayed and connection is
completed, the browser software starts up and the CANON
IMAGE GATEWAY album page is displayed.
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Troubleshooting

If IB is not operating correctly, refer to the items below.
Also refer to the Help from the [Help] menu or click the [?] button at the
top of each window and refer to the Help displayed.

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges.

For how to log in and how to specify Administrator settings, refer to
the User’s Manual for the Macintosh computer or for Mac OS X.

IB does not work

IB does not operate correctly on a computer if its system
requirements does not meet. Use IB on a computer with compatible
system requirements (p.72).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.72), if other applications are running at
the same time as IB, you may not have sufficient RAM (memory). Quit
any applications other than IB.

The software preferences file may be corrupted. Quit all applications
and follow the procedure below to delete the preferences file from the
[Preferences] folder before restarting IB.

In the hard disk drive where the system is saved, open the [Users]
folder P> folder of the logged in user P [Library] folder » [Preferences]
folder, and delete the preferences files below.

Preferences Description

Preferences file for the
ImageBrowser

com.canon.ImageBrowser.plist

com.canon.RAWImageTask.plist Preferences file for the RAW
Image Task

Preferences file for the
PhotoStitch

com.canon.PhotoStitch.plist

Images do not display properly

Images that are not supported by IB (p.72) do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly.

With initial settings, the color of images that have been shot in Adobe
RGB appear weak. In this case, check the [Browser Window] window
in preferences and checkmark [Adjust Image Colors Using a Monitor
Profile] (p.63). Color management is performed and the color of the
image shot with an Adobe RGB setting and the image shot with an
sRGB setting are matched.
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I I I Introduction
Deleting the Software (Uninstalling)
Quit gny applications before gnmstallmg the software. ) . @ You cannot retrieve data that you have emptied into the Trash
To uninstall the software, log into the account used when installation and deleted, so be particularly careful when deleting data. Table of
was performed. _ You cannot install the software again if you have just moved the Contents
To prevent computer malfunctions, always restart your computer after [ImageBrowser] folder to the trash. Be sure to select the [Finder]
you have uninstalled the software. menu » [Empty Trash].
Basic
Display the folder in which the software is saved. CpE R
Open the [Canon Utilities] folder.
‘e‘ﬂ:h 22= m | ‘T| & Q = Advan Ced
yre— - A Operation
g | © 5 &
S cos03 = 3 5 High-Level
Zl Classic ’ &
Bowo P:f wﬁgiM, g? Functions
;Deskmp 5
5
| By pociments i . Preferences
[ Movies
& Music /
| Pictures TextEdit mhm‘uil:t!;:;hme L Canon Utilities >
Using the
Drag the [ImageBrowser] folder to the Trash. Internet

Select the [Finder] menu on the desktop P [Empty
Trash] ) Reference
The software is deleted.

Restart your computer. Contents
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System Requirements

Even though the following are recommended system requirements, not
all computer functions can be guaranteed.

Supported Images

oS Mac OS X 10.4 t0 10.6

Computer | Macintosh with one of the above OS installed

CPU* PowerPC G4, G5 (Mac OS X 10.4 to 10.5), or Intel
processor (Mac OS X 10.4 to 10.6)

RAM* Minimum 512MB (Mac OS X 10.4 t010.5), Minimum 1GB
(Mac OS X 10.6)

. Resolution : 1024 x 768 or more
Dl Colors : Thousands or more

This software program is not compatible with UFS (UNIX File System)
formatted disks.

* Use a Core 2 Duo 2.6GHz or higher CPU and 2GB or more RAM
when working with MOV movies. However, even if there is nothing
wrong with a movie file, it may drop frame and not play smoothly
during playback, depending on your computer specifications.

Introduction

Image type Extension
JPEG images shot with a Canon digital (-:rgr?tlgnotfs
JPEG images | camera (Exif 2.2, 2.21 or 2.3-compatible | .JPG, .JPEG
JPEG images)
RAW images shot with a EOS DIGITAL .CR2 Basic
RAW images | camera excluding EOS D6000, EOS TIF Operation
D2000, EOS DCS1, EOS DCS3 .CRW
TIFF images | Exif-compatible TIFF images TIF, . TIFF
- - - Advanced
BMP images | Bitmap images .BMP Operation
PICT images | PICT images PICT
. MOV movies shot with a Canon digital MOV High-Level
MOV movie camera MOV + .THM* Functions
: AVI movies shot with a Canon digital .
AVI movies Y. AV 4+ . THM
* A “THM" file is a (thumbnail) file generated and saved together with a =i e
movie file when shooting movies with some of Canon digital cameras.
It has the same file name as the movie and includes shooting
information, etc. When you play on the camera a movie file that was Using the
saved together with a “. THM" file, both the movie file and the “. THM” Internet
file are required.
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List of Main Window Functions

Preview Mode

Image display area

[ . ImageBrowser File Edit View Internet Window Help 4 Tue 5:11 PM e ]
,B 86 [ Browser Window 1
Images acqguired from your camera [ Preview Mode List Mode
can be accessed here
¥ Basic
File Name: IMG_0001
Medified: XX XX OO
File Size: 7.0 MB
Image Size: 3888 x 2592
Data Type JPG
[ Favorite Folders | All Folders Sound:
(" v[2 Pictures B tock =
l’;}g'thata Library -
ﬂl’?ii;?;’;xm ¥ Rating j My Category
[,) xxxx:xx:ﬂz PR/ QU X G ¢ i ] ]
-t — Information display area
[:Q Movies ¥ Comment
FOlder al’ea*l— ¥ Keyword
(" view/Modify Keywords... )
¥ Brightness Hsitogram v
| I | | Y
i — Thumbnail image
: display area*?
'7' Shows/hides the folder area
. . Shows/hides the task buttons
Filter display _
(p20) L IMG_0001,JPG IMG_0002JPG IMG_0003JPG IMG_0004.PG IMG_0005 JPG Shows/hides the
, — | " information display area
\ J View | =% Filter Taol i |'-—6—- Q -':L,’ Selecting Images ‘ H3=A p y
T T
, = = lect lects all th
Enlarges/ 3 = ) s B B Selec s/deselects all the
reduces the ,T‘ e Canon Camera View Image SlideShow ug;nimncﬁ Print & Email Send to Trash |mages
thumbnall (No. of images Selected: 1/ Total: 16 images) 4| Number of Selected |mageS/

images (p.11)  starts up EOS Utility/Displays

Download images window
(P.7,p.9) Viewer window (p.75)

Slide show (p.40)

Deletes images and folders (p.25) Total number of images

Prints images and creates images for e-mail (p.15, p.41, p.45, p.46)

Connects to the CANON iIMAGE GATEWAY

xl Images in folders selected here are displayed on the thumbnail image display area.

*2 Images selected here are displayed on the image display area.

)
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List Mode

Movie icon

[ ' ImageBrowser File Efit View Internet Window Help

(@06

|~ Browser Window

4 TuesllPM @ |

Preview Mode

F— tistMode )

Images acquired from your camera

can be accessed here.

RAW

RAW image icon

Bracketing icon

Image display area

Audio recording icon

Shows/hides the folder area

Shows/hides the task buttons

Selects/deselects all the

images

— Number of selected images/
Total number of images

‘Favorite Folders | All Folders
( [ search Results 2 -
w[# Pictures MVI_0000.MOV IMC_0001.CR2 IMGC_0003.CR2 IMC_0004.CR2 =
[; iPhoto Library [RAW]
¥ xoo0e X _xx
[ oo xx 01
[ xx_xx_02
XX_Xx_03
[ xxxx_xx_{
[:&‘{ Movies . .
o = @
IMG_0005.CR2 IMG_0006.CR2 IMG_0008.CR2 IMG_0009.CR2
RAW W3} (WD}
Folder area*
PrOteCt ICOI’] = IMC_0010.CR2 IMG_0011.CR2 TMG_0013.CRZ TMC_0014.CRZ
@ o il
Filter display s
(p.20) :
Enlarges/ : - = ' =
niarges ; = ]
J 3 4 W, E R
reduces the ’T‘ i Canon Camera View Image Slideshow cAnon ace Print & Email Send to Trash
thumbnall (( Mo_of images Selected: 0 / Total: 17 images )4
images (p.11) . . _
Starts up EOS Utility/Displays Slide show Deletes images and folders (p.25)
Download images window (p.40) Prints images and creates images for e-mail (p.15, p.41, p.45, p.46)

(p.7, p.9) Viewer window (p.75)

* Images in folders selected here are displayed on the image display area.

Connects to the CANON iIMAGE GATEWAY
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List of Viewer Window Functions

Display magnification
(p.19)

(@06 E& IMG_0001.JPG (1/16)

"Fit to window

Switches
between images

53 é:& ER = - N :/EP
< > @ N~ = 5= 2 [ = -
Back Next Save Edit Mumber of Displays Synchronize Full Screen — Print Show
Information
(1mage size: 3888 x 2592 ) | | (pispiay: 19 %) .

Displayed image size

Saves the images (p.28)

Edits the images (p.27)

Display magnification

Photo print window (p.77)

Full view display (p.12)
Split displays (p.48)  Synchronize (p.48)

Image display area

Rating (p.19)

Shows/hides the
shooting information
and AF point

(p.12, p.18)
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Displays the movie

List of Cut Movie Window Functions 9

Current position during movie play —

Plays the movie/Stops the movie

Cut M_o*_urie

Adjust volume

Sets the start point for a movie cut ——

. SN

41

[

'”k AR '

0:00.0/0:06.0

Set Time: 0:06.0

Y . -
| Cancel | Save

Previous frame

—— Next frame

—— Sets the end point for a movie cut

Saves a cut movie as a separate movie
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List of Photo Print Window Functions

Printer selection and settings Table of
Contents
re 88 Photo Print !
Basic
Printer Operation
" Canon XXX |--$-—]
Page settings { Page setup... ) Advanced
Operation
Paper size :
A4
High-Level
Click [Page Setup] to enable Functions

borderless printing on
supported printers.

Print preview

)

Introduction

-

Preferences
Using the
Shooting Date/Time Internet
Shot date and — None s
time settings | et
i s Reference
Inserts text
Trims the imaae B Remove unwanted regions ‘ pizi | Add some text to print
9 "—i'! of your photo. -]'& with this photo. Contents
Lookup
Image: 1/1 [Copies: 1 QJ Total : 1 pages
( Close 3 € Print ) Index
A

-

QO
O

Switches the printing image Number of prints
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List of Index Print Window Functions Introduction

Table of
Contents
rﬁ 06 Index Print N
: Basic
Printer Preview Operation
Name: o G e e e el e e B o e
Printer selection —————— canon XxX H nd )
and settings r \ A vantqe
( Page setup... :J peration
Paper size :
Ad High-Level
Functions

Orientation: Portrait

Print preview

On printers that support borderless
printing, this feature is not

Page settings recommended.Click [Page Setup] to Preferences
change this setting.
— (1 .
Copies: 1S Using the
Internet
Page Layout Settings
Rows: 3 3
R 3 E Reference

Page Caption Settings

f"" )
™ Shooting Information Page: 1/3 Contents
. . . [
Print information————— = - - N Lookup
settings SR @.- g ol ]. Trims the image
— Rotate Left Rorate Right Trim Image
Settings... Index
( Close } ( Print :’J -
Q0
Switches the printing page Rotates the image @
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List of Layout Print Window Functions

Sets the printing
style

Printer selection
and settings

Page settings

(@06

Layout Print

Print Style

[ - i
— Custom layout printing

7

Printer

Mame:

' Canon XXX

( Page setup...

Paper size :
Ad

Orientation: Portrait

Click [Page Setup] to enable
borderless printing on supported
printers.

Preview

5‘5 E bl ) (=TT Q
et
Rotate Left Rotate Right Trim Image Images Re-Layout Clear
per Page
( Clpse ) Save ) lC Print )

— Print preview

Rotates the image

Trims the image

Number of images per page

Deletes an image
Reverts to the original condition

G
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Introduction

Contents Lookup Table of
Downloading Images to Your Computer Image Editing contents
Download images by connecting your camera and computer =>p.7 Use automatic adjustment =>p.27 P
Download images using a card reader ->p.8 Adjust brightness/darkness - p.29 Operation
. Make colors more vivid = p.29
Image Checking Trim parts of an image = p.29 Advanced
Look through 2 p-10 Specify an aspect ratio that matches the size of e
Enlarge and view = p.11, p.18 the paper on which an image is to be printed = p-29
Play a movie - p.13 Make an image sharp - p.31 ';:'f:(;hs‘r’]‘:'
Check efficiently =>p.21 Insert text -» p.30 { J
Compare multiple images - p.48 ® Correct red-eye = p.32
Check the shooting information such as shot - p.49 @ Merge =» p.60 g
date » Edit movies - p.34
View as a slide show = p.39 Cut a favorite scene from a movie -» p.38 Using the
Image Printing ® Extract still images from movies = p.51 a
Print one image on one page = p.15 T
Arrange multiple images on one page and print =» p.45 Ufbl\ltlzjcl::ir:ri?nzzzio an e-mail - p.a1 Reference
Arrange images freely and print - p.46 Make into computer wallpaper - p.42 —
Organizing Images Make into a computer screen saver =» p.43
Sort by rating - p.19 Use CANON iMAGE GATEWAY - p.67
Move to a different location -» p.23 Converting Images
Move by entire folder to a different location - p.24 Change the size - .49
Change the file name = p.24 Convert to a different type = p.49 @ @
Delete = p.25
Classify by shot date - p.54 @
Search = p.56
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Rewriting Images to a Memory Card..............uveevvevevvvreeeeeeerireeeeeeeeenne. 14
S

Searching for IMages ... 56
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Thumbnail Display (Main WINAOW) .........cceveeiiiiiiiiiiieceenieeeeeee e 10
Transfer Images to other Image Editing Software................................ 59
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TrMMING @N IMAQgE........ccoiveiiiiieee e, 29
\

VIEW AN IMAQGE ....uuiiiiiiiiiiiiiiiiieieeiieeeeeeeeee e e e e e eeeeeeeeeeeeeereeeeeeeeeaeeaaeeaaeeaaaees 9
ViIEWET WINGOW.......uuuuueiiiiiiiiiiiiiiieiiietiieeeaeeeeeeeeeeeeeeeeseenseeeneennees

Viewer Window Settings (Preferences)
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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